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Version history 

Version Date Description 

1.0 07/2020 Initial release 
1.1 10/2020 Release of tiled orders and document improvements 
1.2 09/2021 Formatting updates 

 

Purpose of this document 

This document provides information about and insight into the AddressBase Core product and its potential 
applications. For information on the contents and structure of AddressBase Core, please refer to the 
Overview and Technical Specification. 

The terms and conditions on which AddressBase Core is made available to you and your organisation are 
contained in that Ordnance Survey customer contract. Please ensure your organisation has signed a valid 
current customer contract to be able to use AddressBase Core. 

We may change the information in this document at any time, giving you the notice period set out in your 
contract. We do not accept responsibility for the content of any third-party websites referenced or 
accessed in or through this document. 

This document has been screened according to Ordnance Survey's Equality Scheme. If you have difficulty 
reading this information in its current format and would like to find out how to access it in a different 
format (braille, large print, computer disk or in another language), please contact us on: 
+44 (0)3456 05 05 05. 

Copyright in this document 

© Ordnance Survey Limited 2021. This document (including for the avoidance of doubt, any mapping 
images reproduced within it) is protected by copyright and apart from the rights expressly granted within 
this document to use the content, all rights are reserved. Any part of this document may be copied for use 
internally in your organisation or business so that you can use AddressBase Core under the terms of your 
licence (but not otherwise). 

No part of this document may be reproduced or transmitted in any form or by any means (including 
electronically) for commercial exploitation, onward sale or as free promotional material without getting the 
written consent of Ordnance Survey beforehand. 

The data in AddressBase is provided by GeoPlace, a limited liability partnership between the Local 
Government Association and Ordnance Survey. 

AddressBase Core contains data created and maintained by English, Welsh and Scottish Local Government 
as well as Royal Mail: 

• © Local Government Information House Limited copyright and database rights 2021, or © Hawlfraint a 
hawliau cronfa ddata cyfyngedig Tŷ Gwybodaeth ar Lywodraeth Leol 2021. 

• This product contains data created and maintained by Scottish Local Government. Please note that 
AddressBase contains public sector information licensed under the Open Government Licence v3.0. 

• PAF data are copyright material of Royal Mail Group Limited. 
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Trademarks 

Ordnance Survey, OS, the OS Logos and AddressBase are registered trademarks, and AddressBase Core is 
a trademark of Ordnance Survey, Britain’s mapping agency. 

PAF, PO Box, Post Office and Royal Mail are registered trademarks of Royal Mail Group Ltd. 

Contact details 

OS website ‘Contact us’ page (https://www.ordnancesurvey.co.uk/contact-us).  

https://www.ordnancesurvey.co.uk/contact-us
https://www.ordnancesurvey.co.uk/contact-us
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1. Introduction 
AddressBase Core is an easy-to-use, accessible addressing data product that gives Plug and Play access to 
complete and accurate address data. It takes key elements from existing AddressBase products and places 
them into a new simplified product. AddressBase Core is available to Public Sector Geospatial Agreement 
(PSGA) members, OS Partners and to commercial customers under commercial licencing. Please note that 
not all of the product variations will be available to each of these groups. 

AddressBase Core's primary source of addressing information is Local Authority data. They have the 
statutory responsibility to capture and maintain Great Britain's address data, which ensures its authenticity 
and authoritative nature. Records are supplemented with Royal Mail Postal Address File (PAF) information 
where it is matched to a Local Authority address. Also, Ordnance Survey is adding additional information 
on the usage of the address and unique identifiers to allow links to other OS products and third-party 
datasets. 

The instructions contained in this document show you how to use AddressBase Core. The data is supplied 
as comma-separated values (CSV) or GeoPackage. This guide covers the steps required to load into various 
geographic information system (GIS) software application and/or databases, including how to apply a 
change-only update (COU). It is important to note that this is not an extensive list of the applications it can 
be used in, and many other GIS software applications and/or database can be used to load the product. 
Ordnance Survey does not recommend specific suppliers or software products, as the most appropriate 
system will depend on many factors, for example, the amount of data being taken, resources available 
within the organisation, the existing and planned information technology infrastructure and the applications 
that AddressBase products can be used for. 

1.1 Target audience 

This document is intended for users with basic technical knowledge of GIS/databases who are comfortable 
navigating the internet. 

1.2 Support resources 

Find further resources on the AddressBase Core product support webpage, which includes: 

1. A Technical Specification. 
2. A classification codes look up table. 
3. A GSS code look up table.  

https://www.ordnancesurvey.co.uk/business-government/tools-support/addressbase-core-support
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2. Data supply 
AddressBase Core is supplied in two optional offerings: 

• As a Managed Great Britain Set (MGBS), which provides national Great Britain data in one of two 
formats: CSV and GeoPackage.  

• In 5km tiles, in either CSV or GeoPackage – CSVs will be supplied as individual tiles if multiples are 
selected by the user, whereas GeoPackage will only ever be supplied as one file. 

2.1 Backup provision of the product 

You are advised to copy the supplied data to a backup medium. This is particularly useful if you take a COU 
supply to keep an archive of records. Information on how to do this can be found in Section 5.5.1. 

2.2 Typical data volumes 

For reading purposes, it is recommended to store the data on a single hard disc. This will speed up the 
ability of your computer to read the data. 

Unzipped file sizes for a full supply of the product are as follows: 

• CSV  8GB 
• GeoPackage  12GB 

Unzipped file sizes of the COU will vary upon each release as this will be dependent on the number of 
changes or records within a given tile. 

2.3 Download 

PSGA customers can download full supply and COU of AddressBase Core via our download service. 

1. When you click Download data, you will be required to enter a password to access the PSGA members’ 
area. On successful entry to the download service, you will be able to view all your orders in the 
members’ area and download your data. 

2. If you have ordered your data from our online portal, you will be sent an email with a link to a 
download page. 

3. Within the PSGA members’ area, you can order and download the data that you require by clicking on 
Order Data, which is found under the Map Data heading. 

4. Once you have selected Order Data, you will be presented with the Order page. From here, you can 
manage all your orders, including those for AddressBase products. 

5. When you have placed an order for a product, the data will become available as a zipped data file. To 
unzip these files, please refer to Section 2.4. 



ADDRESSBASE CORE – GETTING STARTED GUIDE 
September 2021 

 

OFFICIAL 
© Ordnance Survey Ltd 2021 Page 8 of 56 
 

2.4 Unzipping the data 

The CSV and GeoPackage data are supplied in a compressed form (zip). Some software can access these 
files directly, while others will require it to be unzipped. 

To unzip the zipped data files (.zip extension), use an unzipping utility found on most PCs, for example, 
WinZip. Alternatively, open-source zipping/unzipping software can be downloaded from the Internet, for 
example, 7-Zip. 

The first level zip folder will contain the following: 

• Order Details.txt – a summary of the order including order type, format and information on files 
supplied. 

• Zipped folder with the product inside – this will be named as followed: 
AddressBaseCore_{variant}_{order_date_YYYY-MM-DD}_{file_number_NNN}.{format}.zip 

• variant = FULL, COU 
• order_date = the date when the order was received, for example, 2020-02-11 
• file_number = three-digit zero padded file number, for example, 001 
• format = csv, gpkg 

Example:  
AddressBaseCore_FULL_2020-01-30_001.gpkg.zip 
or 
AddressBaseCore_COU_2020-01-30_001.csv.zip 

The product within the zip folder will use the same naming convention as above but without the .zip at the 
end. 
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3. Loading AddressBase Core into GIS software 

3.1 ArcGIS Pro 

For the purposes of illustration within this guide, version 2.3.3 of ArcGIS Pro is being used. Other more 
recent releases of the application should perform in a similar manner. 

3.1.1 Loading CSV data 

1. Create a new blank map project in ArcGIS Pro and select an appropriate map backdrop to use as 
context against which to display the data. 

2. In the creation of the project, ArcGIS Pro will create a new File Geodatabase into which data can be 
loaded. 

3. Select an area in the mapping which displays the backdrop of the area of the country of interest. 

a. On the right-hand side of the window, open the Catalog pane. 

b. Expand the folder structure to show the new file geodatabase created with the project. In this 
example, the database is called AddressBase Core. 

 

 

4. Right-click on the file geodatabase and in the context menu, select Import table. A new geoprocessing 
window will appear. 

5. Fill in the boxes appended with a red asterisk. 
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6. Navigate to the location of the AddressBase Core .csv file. 

7. Provide a name for the output standalone table. Once this has been done, a window should appear 
similar to that in the following image. 

 

8. Once satisfied, click the Run button. 

The application will now run a script to load the CSV file into the file geodatabase. A green tick box 
message will appear when complete. A new standalone table will appear in the left-hand pane. 

 

The contents of the new standalone table can be displayed by right-clicking on the new table and 
selecting open. The contents of the file are now displayed in a new browsing window. 
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The standalone table is displayed as a browsing table. To be able to display the contents of the table 
against the map backdrop, you will need to display the XY data in the table by carrying out the 
following instructions. 

Displaying the address location 

1. Right-click on the AB_Core standalone table in the left-hand pane and select Display XY Data. A new 
geoprocessing window will appear on the right-hand side. 

 

2. Select the X Field (normally easting) and Y Field (normally northing). 

3. Select the British_National_Grid option from the coordinate system dropdown list. The completed box 
should appear similar to that shown in the previous image. 
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4. Click the Run button, when satisfied. The process will now run, and a green tick box message will 
appear when complete. 

The AddressBase Core data will now display against your chosen mapping backdrop, as shown in the 
following image. In the left-hand side pane, a new feature class will have appeared called 
AB_CoreXYTableToPoint1. 

The data can now be interrogated and styled according to your preferences. 

 

3.1.2 Loading GeoPackage data 

The AddressBase Core project created previously for the loading of CSV data described in the previous 
section can be used for the addition of the GeoPackage supply of the data. 

1. In the project, make sure the Catalog window is open on the right-hand side of the main window. 

 

2. Right-click on Folders and select Add a new folder connection. 

Browse to the location of the GeoPackage file for the AddressBase Core product and select that folder. 
Once this has been done, the AddressBase Core GeoPackage should appear as a database in the 
Catalog window, as illustrated in the previous image. Allow it a little time to make the connection as 
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the ArcGIS Indexing server works in the background on the GeoPackage file before it is displayed. The 
national AddressBase Core GeoPackage file is over 13GB in size, so this will take a few minutes. 

3. The coordinate reference system of the basemap being used as a contextual background should be set 
to British National Grid before loading the main.abcore_address element into the map backdrop. 

4. Click the arrow to the left of the GeoPackage entry to expose the component element within the 
GeoPackage. This is the file which contains the data. 

 

5. Right-click on the abcore element – in this example, main.abcore_address – and then select Add to Current 
Map. 

It will now appear in the left-hand side of the main map window in the contents pane. Give the 
application a few minutes to load the data, especially if loading a national set. The following image shows 
a smaller GeoPackage covering part of Hampshire which has been loaded into ArcGIS Pro using the 
method described above. 
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3.2 ArcMap 

For the purposes of illustration within this guide, version 10.5.1 of ArcMap is being used. Later releases of 
ArcMap should behave in a similar fashion. 

3.2.1 Loading CSV data 

1. Open ArcCatalog and create a new file geodatabase into which the AddressBase Core data will be 
loaded. 

2. Give the file geodatabase a name and save it in a suitable place. 

 

3. Right-click on the new file geodatabase created and select import table (single). A new dialog box will 
open. 

 

4. Enter details of the CSV table being loaded plus the output table it will be called within the file 
geodatabase. 

When populated, the dialog box will look something like the following image. The Field Map section can 
be left as default as we wish to add all the fields within the CSV file. 
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5. Click OK when ready to proceed. 

Once the process has been completed, a green tick window will appear. In Arc Catalog, you will notice 
that the CSV file has been added to the file geodatabase. 

 

Creating the address location geometries 

To display the data in the CSV file against a mapping backdrop, a new feature class will need to be created 
using the XY coordinates from the table. Use the following instructions to complete this task. 

1. Right-click on the new table, select Create Feature Class and the subsidiary option From XY table. 

 

2. Select easting for the X Field and northing for the Y Field. 
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3. Select British National Grid as the coordinate reference system of the data to be output. 

 

4. Click OK. 

5. Next, the output needs to be specified by clicking on the folder button next to the output path dialog. 

 

You can specify a shapefile output or a new feature class within the file geodatabase created. 

6. Select the latter of these options and give the output a name. 

7. Click Save and OK in the previous window when finished. 

In Arc Catalog, a new feature class will have been created as containing point features. 
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Displaying the address location 
In ArcMap, open a suitable backdrop map to overlay the data against. This can be from locally held data or 
using one of several available WMS or WMTS mapping services available, some of which are free to use. 
Carry out the following steps to achieve this. 

 

1. In ArcMap, click Add Data. 

 

2. Navigate to the folder that contains the geodatabase file and select the XY feature class. 
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3. Once satisfied, click Add. 

 

The AddressBase Core data is now displayed and ready for use in ArcMap. 

3.2.2 Loading GeoPackage data 

1. In Arc Catalog, connect to the folder that contains the AB_Core GeoPackage data. 

A new folder connection will need to be created if one doesn't already exist. In the example shown 
below, the connection in Arc Catalog has been made and the GeoPackage has been expanded to show 
the main.abcore_address element containing the AB_Core data within the GeoPackage. It is this data 
which will be added to the backdrop mapping in ArcMap. 

 

2. In ArcMap, click Add Data, then simply navigate to the folder which contains the GeoPackage and click 
on the main AB_Core element within the GeoPackage. 
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3. Select it and then click Add. 

 

The data from the GeoPackage now loads into ArcMap. Unlike in the CSV option, there is no need to 
specify a coordinate reference system for the AB_Core data because that information already exists in 
the GeoPackage. 

However, you will have to change the coordinate reference system of the backdrop mapping used to 
British National Grid beforehand to get the data to display in its correct position in relation to the 
backdrop map. 
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3.3 QGIS 

For the purposes of illustration in this guide, version 3.10.5 of QGIS is being used to demonstrate loading 
and displaying of the data. This is the current Long-Term Release version of QGIS (May 2020). It is 
expected that the procedures described here will work the similarly in later versions. 

3.3.1 Loading CSV data 

1. Launch QGIS with a blank new project. 

For contextual backdrop mapping, you can use either a local data holding or an online mapping service 
from one of several providers, including Ordnance Survey. 

 

In this illustration, we will be using the OS Maps API light background as a contextual map. Make sure 
that the coordinate reference system is set to EPSG 27700 (British National Grid). 

 

2. Click on the button of the side toolbar which has a comma on it: Add Delimited Text Layer.  

It is assumed that you have this toolbar activated in your QGIS setup. To activate it, go to the main 
menu and select View > Toolbars > Manage Layers toolbar, and make sure that the box next to this 
option is ticked. 
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3. In the next window, you will specify the location of the AddressBase Core data CSV file and make sure 
that the X field box is set to easting and the Y field is set to northing. The first record in the data in this 
instance has field names, so that box must be checked. 

 

4. When satisfied, click add. The data will now load into QGIS. Close the window. 

 

Once loaded, the data can then be interrogated and styled differently, if required, using the tools within 
QGIS. 
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Adding a spatial index to the data  

TIP: Improve rendering performance by adding a spatial index to the data. The following instructions 
outline how to do this: 

1. Right-click on the AB_Core entry in the layer window, then select Properties.  

2. Click on the source tab on the left. The following window will appear. 

 

3. Click Create Spatial Index. The index will be built, improving the rendering of the data for use. 

4. Close the window when completed. 
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3.3.2 Loading GeoPackage data 

1. Launch QGIS and select a suitable mapping backdrop to provide geographical context. In this 
illustration, we have used the open dataset OS Zoomstack to provide a mapping context. 

2. When loading the CSV data, ensure that the map window coordinate reference system is set to EPSG 
27700 (British National Grid). 

 

3. Click the Add vector layer button in the Layers toolbar on the left-hand side of the map window. 
Instructions on how to load this toolbar are supplied in point 2 of Section 3.3.1. 

 

4. In the next window, browse to the location of the folder where the GeoPackage file is located by 
clicking on the button with three dots to the right of the dialog box. 
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In the next window, browse to the location of the GeoPackage file. 

 

5. Select the file to be loaded and click OK. 

It should be noted that it is possible to filter out other files in the folder which are not GeoPackages by 
setting the files of type box (in the bottom right-hand corner of the window) to GeoPackage. 

6. When satisfied, click Add. The GeoPackage data will now load into QGIS. 
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7. Click Close to close this window. 

The GeoPackage data is loaded into the map window. It can now be used for interrogation with the 
tools available within QGIS and styled differently using the available tools if required. 

 

The GeoPackage data does not need a spatial index to be created as that indexing is normally held within 
the GeoPackage itself. 
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3.4 MapInfo Professional 

For the purposes of illustration within this guide, version 16.0.4 of MapInfo Professional is being used. More 
recent releases of the application should perform in a similar fashion. 

3.4.1 Loading CSV data 

1. Launch MapInfo Professional. 

For contextual purposes, load a suitable map backdrop to provide context for the AB_Core data. This 
can be map data held locally or from a wide variety of online sources, some of which are free to use. In 
this guide, the OS Maps API light backdrop canvas is used, with the coordinate reference system set to 
EPSG 27700 (British National Grid). 

2. Once the map backdrop has been loaded, as in the illustration two down, select the Table tab in the 
ribbon menu at the top of the window. 

 

You may have set up a quick launch button to open tables at the very top of the window. The following 
image is an example of what the backdrop map could look like. 

 

3. Click Open. 

4. Select Table. 
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5. In the next window, browse to the folder where the AB_Core data is stored. Change the Files of type 
dialog to Comma delimited CSV (*.csv). The Preferred View dialog can be left as Automatic. 

 

6. Click Open. 

7. In the next window, leave the Delimiter as a comma and the File Character Set as Unicode UTF-8. 

 

8. As the AB_Core data already contains the header information within the CSV file, tick the box Use First 
Line for Column Titles. 

9. Click OK when finished. 

The AB_Core data will now be loaded into MapInfo Professional in a table browser window and will 
appear in the list of loaded windows in the left-hand pane. 
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To display the data against the mapping backdrop, the table will need to be geocoded, or in other words, 
the XY coordinates will need to be specified. To do this, follow the instructions below. 

Displaying the address location 

10. In the top ribbon menu, click on Spatial and then select the Create Points button. 

 

1. In the next window, several options need to be set correctly in the various dialog boxes. 

 

a. The symbology for the added points can use various symbols from a library of appropriate symbols 
loaded with MapInfo. 
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b.  Set the Projection to British National Grid 

c. Set the Get X Coordinates from dialog to easting and the Get Y Coordinates from dialog to 
northing. 

d. Click OK when finished. 

2. Select the Table tab in the ribbon browser and click table-open or use a short cut if one is defined. 

3. Select the newly created table containing XY coordinates and set the Preferred View to Current Mapper 
so that the data will display against the map backdrop. 

 

4. Click Open when satisfied. 

The AB_Core data is now displayed against the chosen mapping backdrop. It can be used for 
interrogation purposes using any number of tools available within MapInfo Professional. 

 

5. Save the workspace in MapInfo Professional for future use. 
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3.4.2 Loading GeoPackage data 

Note that versions of the application before the 16.0.0 release of MapInfo Professional do not support the 
GeoPackage format. Versions from 16.0.0 onwards fully support the format. 

1. Launch MapInfo Professional.  

2. Add a custom backdrop map as described in point 2 of Section 3.4.1. 

 

In this example, we are using the OS Maps API light backdrop canvas set to British National Grid, as 
was used in Section 3.4.1 – Loading CSV data. 

3. Select Table in the ribbon menu, then select Open – Table or use a quick launch button to do this if it 
has been set up in MapInfo Professional. 

4. In the next window, navigate to the AB_Core GeoPackage data location. 

a. Change the Files of type dialog to GeoPackage (*.gpkg). 

b. Change the Preferred View dialog to Current Mapper so that the data will display against the 
backdrop contextual mapping chosen. 

c. Select the file to be loaded and click Open. 

 



ADDRESSBASE CORE – GETTING STARTED GUIDE 
September 2021 

 

OFFICIAL 
© Ordnance Survey Ltd 2021 Page 31 of 56 
 

5. In the next window, the style of the loaded data can be changed to one of several different styles 
available within MapInfo. 

 

6. Select a style and click OK. 

7. The location of the newly created .TAB folder which will source the GeoPackage can also be specified. 

8. When satisfied with the selections, click OK. 

The GeoPackage data now loads into the current map window in MapInfo Professional. It is ready for 
interrogation using any one of the available tools within the application. 
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9. The GeoPackage data can easily be browsed by right-clicking on the new GeoPackage layer in the 
contents pane and selecting Browse. 

 

A new browser window will appear alongside the map window in the main display window. 

 

10. Save the workspace in MapInfo Professional for future use. 

3.5 CadCorp Map Modeller 

For the purposes of illustration within this guide, version 9 of CadCorp Map Modeller is being used. 
Although the procedures described here may work with earlier releases, it is recommended that you use 
the current version of the application. 

3.5.1 Loading CSV data 

1. Launch CadCorp Map Modeller and choose a suitable backdrop map for use as a contextual backdrop. 
To do this, follow the instructions listed below. 

a. Open a blank map, ensuring that the default coordinates are set to British National Grid. 

b. To add a backdrop map, click Add Overlay. 
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c. A list of overlays is provided. The one used in this illustration is Web > Tile Dataset. Select that 
option and click Next. 

 

d. In the Tile Dataset window, click the arrow to the left of the Ordnance Survey (GB) entry and select 
the OS Open Zoomstack option. 

 

e. Select any one of the available styles. 

f. Click Finish. 

The backdrop mapping is loaded. For this option, an internet connection is required. You could use a 
locally held overlay of data as an alternative option. 
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2. To add the CSV data, select Add Overlay. 

 

3. In the Overlay Types window, select Databases in the left-hand pane, then select View Points. 

 

4. Click Next. 
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5. In the next window, select Comma Separated File and click Next. 

 

6. Browse to where the CSV file is located, select the file to be loaded and click Next.  

 

The next set of windows will configure the data being loaded so that it will display properly. 
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7. Make sure the Keep first line box is checked, then click Next. 

 

8. In the next window, make sure that the First Row Contains Field Names box is checked, and the Text 
Qualifier dialog is set to a comma.  

 

9. Click Next. 
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10. The Database columns window does not require any configuration. 

 

11. Click Next. 

12. In the next window, we want all the data fields to be loaded, so click on the CSV file in the left-hand 
pane and using the arrow, click for all the columns that appear in the right-hand pane. 

 

13. Click Next. 
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14. In the next window, set the X Field dropdown list to easting and the Y Field dropdown list to northing. 

 

15. To set the coordinate reference system for the data, click the More Properties… button in the bottom 
right-hand side of the window. 

16. Change the coordinates to OSGB 1936.British National Grid from the dropdown list. 

 

17. Click OK. 

18. Then click Finish. 
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Displaying the address location 

You may not see the AB_Core data displayed against the backdrop mapping in the main map window. This 
is because the default styling may have set the data to display in a form which is too small. To change this, 
follow these instructions. 

1. Right click the AB_Core entry in the Maps pane and select Properties. 

 

2. In this window, change the Symbol type from a dot to some sort of circle, and then change the Point 
size so that it moves closer to a value of 0 but still has a negative number. You should experiment to 
see what is most useful for your purpose. 

 

3. Click Apply when satisfied, then click OK to close the window. 

The data should now load into the map window and, depending on the map backdrop used, will look 
similar to the following example. 
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Save the project as an SWD document in CadCorp for later use. The data is now ready to be 
interrogated using the tools available in CadCorp. 

3.5.2 Loading GeoPackage data 

1. Launch CadCorp Map Modeller. 

As was done in the CSV example in Section 3.5.1, load a suitable map backdrop to provide context for 
the AB_Core data. Set the backdrop map to the British National Grid coordinate reference system. In 
the example, we have used the Roads Style version of the OS Open Zoomstack data as a backdrop. 

2. Click Add Overlay from the top ribbon menu. 

 

3. In this instance, select Files in the left-hand window and select File from the top of the list on the right-
hand side. 
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4. Click Next. 

5. In the next window, browse to where the GeoPackage file holding the AB_Core data is located. The 
files of type box in the bottom right-hand dialog should be set to All known formats. Select the 
GeoPackage file and then click Finish. 

 

The data will now load into CadCorp Map Modeller and appear in the list of Maps on the left-hand side 
of the screen. 

Displaying the address location 

Once again, as with the CSV data in Section 3.5.1, the styling may need to be changed to make the 
AB_Core data visible. The following steps outline how to do this. 

1. Right-click the AB_Core GeoPackage entry and select Properties in the next window. Experiment with 
the type of styling to be applied to the layer. 
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2. Once satisfied, click OK. 

In the preceding example image, a circle has been used as the style and a point size of -0.05 has been 
selected to make the data stand out and be more legible against the backdrop mapping. 

 

The GeoPackage data now appears against the map backdrop and is ready for use within the 
application. 

Once again, in the case of the GeoPackage format, there has been no requirement to specify the 
coordinate reference system as that information is stored within the GeoPackage data. However, the 
backdrop mapping should have been set to a coordinate reference system of British National Grid. 
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4. Loading AddressBase Core into a database 
This section describes how to load the AddressBase Core product into some common databases. 

4.1 Considerations 

4.1.1 Software dependencies 

It should be noted that ArcMap, ArcGIS Desktop and ArcGIS Server software do not support the 
BIGINT/NUMBER data type as an Object ID. Bear this in mind if the expectation is to use this data type 
directly with these ESRI products. An alternative method to facilitate using ESRI software is to store this 
data as a string and add a new Serial ID to act as the Object ID. 

If you are loading AddressBase Core data directly into a database, you may need to increase the column 
length to accommodate language characters such as ^. Some databases treat this as an additional character 
and therefore if you define the column length according to our specification there is a chance the load may 
fail. Please bear in mind such adjustments may be required depending on the database you use to load the 
data. 

4.1.2 UPRN deletions 

It is important to note if a UPRN is deleted and then reinserted, this does not compromise the integrity of 
the UPRN and its use as a primary key. If a delete is issued for a UPRN, this does not mean it will not 
reappear in subsequent supplies. 

There are several reasons this may happen: 

• The record has moved in location more than once, moving it out of your area of interest (AOI; 
therefore the record is deleted) but then back into your AOI in the future. This could also occur if you 
alter your AOI. 

• A record has failed data validation upon a change being made. This can result dependent on the change 
being made in the record being deleted and then reintroduced when the error is fixed by the data 
supplier. 

If a UPRN is deleted, it will not be reallocated to a different property and it therefore remains the unique 
identifier for a property. 
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4.2 PostGreSQL  

These steps describe how to load AddressBase Core into a PostGreSQL database using the CSV files. 

These instructions are based on PostGreSQL version 10 and assume that you have set-up your database 
with the PostGIS spatial extension. It is recommended that you have basic understanding of database 
terminology before following this guide. 

Where <table_name> or similar in < > is used, the entire string is to be replaced, for example: 

COPY <table_name> FROM 'C:\Address\AddressBaseCore_FULL_2020-05-25_001.csv ' 
DELIMITER ',' CSV HEADER; 

Becomes: 
COPY addressbase_core FROM 'C:\Address\AddressBaseCore_FULL_2020-05-25_001.csv ' 
DELIMITER ',' CSV HEADER; 

If referencing a schema, <schema_name>. can be placed in front of any <table_name>, for example: 

COPY ab_core.addressbase_core FROM 'C:\Address\AddressBaseCore_FULL_2020-05-25_001.csv ' 
DELIMITER ',' CSV HEADER; 

Note – If you are using version 11 or above, there is currently a glitch which will not allow a bulk load using 
a CSV. Therefore, it is advised to use the guidance available in Section 3 to load the data into a GIS package 
and then retrospectively add it to your database. 

1. Open PGAdmin tool (this can be found on the Windows Start Menu > PostGreSQL). 

2. Either connect to an existing database or create a new database. It is recommended that the encoding 
is set to UTF-8. 

3. Open the public schema (although in a production environment, it is advised to use a different schema) 
and create the tables using the following steps: 

a. Open the SQL query tool. 

b. Download the AddressBase Core SQL file from the AddressBase_Core folder: 
https://github.com/OrdnanceSurvey/AddressBase/tree/master/Loading_Scripts/PostgreSQL. 

c. This SQL file can be opened in a text editor, and the SQL scripts can be within copied and pasted 
into the SQL query tool within PostgreSQL. This script creates a table called addressbase_core; you 
may choose a different naming convention. 

4. Once the table has been created, the data can be loaded into each table using the SQL COPY. Adding 
the CSV option as the first line contains a header record for each table. 

The path and file name may need to be changed to reflect your data set-up: 

COPY <table_name> FROM 'C:\Address\AddressBaseCore_FULL_2020-05-25_001.csv ' 
DELIMITER ',' CSV HEADER; 

5. Once loaded, you may want to add Primary Keys to the data. However, these can only be added on 
columns where the data values are unique. Where there are no unique data values, an index may be 

https://github.com/OrdnanceSurvey/AddressBase/tree/master/Loading_Scripts/PostgreSQL
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added which will aid searching. The UPRN, UDPRN, USRN and TOID provide the only unique value in 
AddressBase Core. 

Primary Keys are added using the following steps: 

a. Right-click on the table name and select Properties. 

b. Select the Constraints tab. 

c. Click the + symbol to add a new primary key. 

d. Click the edit icon. 

e. Enter a name to call the key under the General tab (for example, Key1). 

f. Under the Definition tab, select UPRN or any other unique value from the dropdown under 
Columns. 

g. Click Save. 

6. You can also index the data by following these steps: 

a. Right-click on the table name and select Create > Index. 

b. Under the General tab, enter a name (for example, Idx1). 

c. Under Definition tab > Columns, click the + symbol. 

d. Select the UPRN, for example, or any other unique value. 

e. Click Save. 

4.2.1 Converting coordinates to geometry 

A PostGIS extension is required to create geometries. The AddressBase products contain both British 
National Grid (BNG) and ETRS89 coordinates. The following SQL shows how to create a column for BNG 
but can be altered to utilise the ETRS89 data. 

1. Add a geometry column called geom to make the data usable in a GIS: 

SELECT AddGeometryColumn ('<schema_name>', '<table_name>', 'geom', 27700, 'POINT', 2); 

2. Load the data into your new geometry column: 

UPDATE <schema_name>.<table_name> SET geom = ST_GeomFromText('POINT(' || easting || ' ' || 
northing || ') ', 27700 ) 

This sets the geom column in the BLPU table to equal the values from the easting and northing 
columns, with the spatial reference defined as 27700. 

3. Create a spatial index (for example, idx_abcore_geom) on the data using: 

CREATE INDEX <index_name> ON <schema_name>. <table_name> USING gist(geom) 
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This adds the index name idx_abcore_geom to the same table on the geom column. 

4.3 Microsoft SQL Server 

The following instructions assume basic knowledge of Microsoft SQL Server. 

Note – There are many ways to load AddressBase products into Microsoft SQL Server; this is just one 
suggested method for guidance. 

1. Open the SQL Server Management Studio (SSMS). 

2. Right-click on the database you are loading into and select Properties. 

3. Select Options on the left-hand side. 

4. Expand the dropdown box for Recovery Model and select BULK-LOGGED. This minimises the logfile size, 
otherwise the default logging for Microsoft SQL Server can cause logfiles to grow over 20GB and this 
can cause issues with loading. 

5. Open the SQL Server Management Studio (SSMS) and right-click your database from the left-hand panel. 

6. Navigate to Tasks and click Import Data. This will open the SQL Server Import and Export Wizard. 

7. Click Next. 

8. On the next screen, change your Data Source to Flat File Source. 

9. Use the Browse button to navigate to and select your CSV file. If you cannot see your files, ensure the 
bottom right dropdown box has CSV files (*.csv) selected. 

10. Click Open. 

11. Ensure the Column names in the first data row is ticked. 

12. Check that the Text Qualifier is set to a double quote (“). This is to make sure the quotations in the raw 
data supply are removed upon loading but that the data remains intact. 

13. On the left-hand side of this screen, select Columns and check that the Column delimiter is set to Comma. 

14. On the left-hand side of the screen, select Advanced. 

15. For each column of data you are loading, you will need to specify a Data Type. The Microsoft SQL 
Server loader defaults each column to a String. The correct Data Types for each column are given in 
the AddressBase Core Technical Specification. 

16. Once you have changed the column types to match the correct Data Types listed in the Technical 
Specification, click Next. 

17. Check that your table is going to be imported into the correct database, then click Next. 

18. On this screen, you can edit the default table name that Microsoft SQL Server has chosen by clicking in 
the destination box. For example, for AddressBase Core renaming to [dbo].[ADDRESSBASE_CORE] 

https://www.ordnancesurvey.co.uk/documents/product-support/tech-spec/addressbasecore-technical-specification.pdf
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19. Select Edit Mappings in the bottom right-hand corner. 

20. In the new window, you must remove the tick in the checkbox against the UPRN column, which needs 
to be the Primary Key of the table. Click OK once the Primary Key alterations have been completed. 

21. Click Next. On this screen, you can check that the Source column and Destination columns are correct. 

22. Click Next. A summary of your import will appear. If you want to continue, click Finish. 

23. A report will be generated as your data is imported. Success should appear at the top once complete. 

24. You may need to right-click on your database and click Refresh to see your new table listed. 

4.3.1 Setting Primary Keys 

To create a Primary Key field you can run an SQL statement, such as the following example for 
AddressBase Core. (Note that the columns you are creating these constraints on cannot be null or allowed 
to be null.) 

alter table dbo.ADDRESSBASE_CORE 
add primary key ([UPRN]); 

4.3.2 Creating the point geometry 

You can also create point geometry using the Eastings and Northings or the Latitude and Longitude 
coordinate values. This is achieved by running the following SQL statement: 

alter table dbo.ADDRESSBASE_CORE 
add geometry_column as geometry::Point([easting],[northing], 27700); 

Note – This is using British National Grid coordinates, with 27700 representing the spatial reference of the 
data. To use the Latitude and Longitude coordinate, the spatial reference should be set to 4258 for 
ETRS89. 
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5. AddressBase Core GB COU implementation 
guidance 

5.1 Introduction 

All the AddressBase products are available as a full supply or a COU. A COU means you will only be 
supplied with the features which have changed since your last supply. The following sub-sections provide 
guidance on how you could potentially manage a COU supply of AddressBase Core using PostGreSQL. 

Where <table_name> or similar in < > is used, the entire string is to be replaced, for example: 

COPY <table_name> FROM 'C:\Address\ AddressBaseCore_COU_2020-06-03_001.csv' 
DELIMITER ',' CSV HEADER; 

Becomes 
COPY addressbase_core_cou FROM 'C:\Address\ AddressBaseCore_COU_2020-06-03_001.csv' 
DELIMITER ',' CSV HEADER; 

If referencing a schema, <schema_name>. can be placed in front of any <table_name>, for example: 

COPY ab_core.addressbase_core_cou FROM 'C:\Address\ AddressBaseCore_COU_2020-06-
03_001.csv' DELIMITER ',' CSV HEADER; 

5.2 Types of change 

At a high-level, there are three types of change found within COU: 

• Deletes (CHANGE_TYPE ‘D’) are objects that have ceased to exist in the product since the last 
product refresh. 

• Inserts (CHANGE_TYPE ‘I’) are objects that have been newly inserted into the product since the last 
product refresh. 

• Updates (CHANGE_TYPE ‘U’) are objects that have been updated in the product since the last product 
refresh. 
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5.3 High-level COU implementation model 

Figure 1 shows how to implement AddressBase Core COU within a database. 

Figure 1: High-level COU implementation model. 

 

5.4 High-level COU implementation model – with archiving 

Before a COU is applied, there may be a business requirement to archive existing address records. Figure 2 
shows how to implement archiving with an AddressBase Core COU within a database. 

Figure 2: High-level COU implementation model on how to create archive tables and apply a COU. 
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5.5 Applying COU to tables 

Within AddressBase Core there will be no records with the same UPRN. This can be tested by checking 
the number of records that have the same UPRN. The following SQL code would notify you of any 
duplicates. 

SELECT uprn, COUNT(uprn) AS NumOccurrences 
FROM <table_name>  
GROUP BY uprn  
HAVING ( COUNT(uprn) > 1 );  

This query should return 0 rows, and this confirms that there are no duplicates. As there are no duplicate 
records, we can use the UPRN to apply the COU. 

5.5.1 With archiving 

Where there is a business requirement to keep the records that are being Updated and Deleted in a 
separate archive table, the following SQL will create an Archive Table. It will populate with records that are 
being Updated and Deleted from the live AddressBase Core table. 

The following command creates an archive table of the records that are being updated and deleted from 
the existing table, for example, addressbase_core_archive. 

1. First, apply the theory from the steps in Section 4.2 to load the COU CSV into a new or existing table, 
for example, addressbase_core_cou. 

2. If this table already exists, you can simply use INSERT INTO <abcore_archive_table_name>, rather than 
CREATE TABLE <abcore_archive_table_name> AS. 

CREATE TABLE <abcore_archive_table_name> AS SELECT * FROM <master_abcore_table_name> 
WHERE uprn IN (SELECT uprn FROM <abcore_cou_table_name> WHERE change_code != 'I'); 

3. The following command then deletes the records from the existing table, which are either updates or 
deletions. 

DELETE FROM <master_abcore_table_name> 
WHERE uprn IN (SELECT uprn FROM <abcore_cou_table_name> WHERE change_code != 'I'); 

4. The following command then inserts the new insert records and the new updated records into the live 
BLPU table. 

INSERT INTO <master_abcore_table_name> 
SELECT * FROM <abcore_cou_table_name> WHERE change_code != 'D'; 

5. You can check that this has been successful by re-checking that there are no duplicate UPRNs. 
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5.5.2 Without archiving 

If there is no requirement for archiving, follow these steps: 

1. First apply the theory from the steps in Section 4.2 to load the COU CSV into a new or existing table, 
for example, addressbase_core_cou. 

2. Now, delete the existing records that will be updated, for example, Updates and Deletions. 

DELETE FROM <master_abcore_table_name> 
WHERE uprn IN (SELECT uprn FROM <abcore_cou_table_name> WHERE change_code != 'I'); 

3. Insert the new updated records. 

INSERT INTO <master_abcore_table_name> 
SELECT * FROM <abcore_cou_table_name> WHERE change_code != 'D'; 

4. You can check that this has been successful by re-checking that there are no duplicate UPRNs. 
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6. Tiled orders 
Tiled orders allow you to select a small region of Great Britain (GB), rather than having to order the whole 
of GB if you so wish. Ordering tiles, as opposed to full GB coverage, can be beneficial as the amount of data 
is reduced. This would reduce the size of your data storage and reduce the time it takes to process the 
data. 

AddressBase Core tiles can be downloaded through Ordnance Survey’s download service. A full 
breakdown on how to access this service is outlined in Section 2.3. To order tiles: 

1. Access the OS orders site and select AddressBase Core – 5km DOWNLOAD. 

2. Select either a self-drawn polygon, a rectangle or a postcode/place. This can be found in the panel 
above the map (as shown in the next image). Once the area is selected, proceed to place your order. 

 

Dependent on whether you are a PSGA customer or an OS Partner, the tiles are supplied as either 
GeoPackage or CSV. 

Once an AOI polygon is drawn, you will be provided with all 5km tiles that intersect the specified area (see 
Figure 3). For a GeoPackage download, you will receive tiled data which has been incorporated into one 
single GeoPackage file. For CSV tile supplies, individual 5km tiles will be supplied for each tile which 
intersects your AOI. 

 

Figure 3: An example of what is supplied when completing a tile order. An area of interest is drawn  
(blue lines) and a tile is provided for anywhere the drawn area of interest intersects (green lines). 
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Figure 4 illustrates the format, coverage and supply type of AddressBase Core, specifically highlighting the 
tile supply options. Each supply type will be covered in the sub-sections that follow, and they are also 
highlighted in Figure 4 with relevant sub-section numbers provided (for example, 6.1). 

 

Figure 4: An illustration of AddressBase Core format, coverage, and supply types specifically for tile supplies. 

6.1 GeoPackage 

Both GB coverage and tiled supply of GeoPackage is produced as a full supply only, as shown in Figure 4. 
Both product variants result in you receiving one consolidated GeoPackage file for your order. 

To use this in your relevant geospatial software, please refer to Section 3, which provides information for 
implementing GeoPackage into ArcGIS Pro, ArcMap, QGIS, MapInfo Professional and CadCorp Map 
Modeller. 

6.2 CSV 

Tile orders are also an option for CSV supplies of AddressBase Core. The CSV is implemented as 5km 
tiles; once downloaded, an individual CSV will be produced for each tile. This is the case for both full supply 
and COU. Each CSV will also be provided with a header; therefore, this must be considered if you wish to 
consolidate multiple individual tiles into one single file. 

A use case for taking tiled coverage is to have a smaller data holding than taking all of GB if only a small 
subset of addresses within GB is needed. If you are planning on using the tile supplies for COU purposes, 
we need to understand the data structure of the full supply and COU files you will download. 

If you select to receive COU tile supplies, if any record within a selected 5km tile is changed between two 
releases of data (each week), you will receive the entire 5km tile in your next supply containing all of the 
latest live records for that tile. 
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As can be seen in Table 1, the original full supply contains the address 17 THE BROADS, PAMPHILL, 
WIMBORNE, BH21 4DR, whilst the next COU data does not (no data represented as a pink cell). However, 
it does include an additional record: 37 THE BADGERS, PAMPHILL, BH21 4SH. This means that the 17 THE 
BROADS address has been deleted between the two releases, and 37 THE BADGERS is a new address. 

Table 1: Example of full supply and COU data to provide an explanation as to the pre-processing method. 

Original full supply COU records COU change type 

BUNGALOW, BLANDFORD 
ROAD, WIMBORNE 
MINSTER, BH21 4DS 

BUNGALOW, BLANDFORD 
ROAD, WIMBORNE 
MINSTER, BH21 4DS 

I (INSERT) 

17 THE BROADS, 
PAMPHILL, WIMBORNE, 
BH21 4DR 

No data supplied Not applicable 

33 THE BROADS, 
PAMPHILL, WIMBORNE, 
BH21 4DR 

33 THE BROADS, 
PAMPHILL, WIMBORNE, 
BH21 4DR 

I (INSERT) 

No data supplied 37 THE BADGERS, 
PAMPHILL, BH21 4SH I (INSERT) 

 

To implement COU, it is advisable to process the full supply and the COU data files into a common 
structure to be used in conjunction with SQL, to keep the database up to date. Therefore, a tilename 
column should be appended onto the full supply and COU data when the CSVs are merged, as shown next. 

AddressBaseCore_COU_2020-01-30_SU2075.csv.zip 

POST_TOWN ISLAND POSTCODE DELIVERY_POINT_SUFFIX GSS_CODE CHANGE_CODE TILENAME
SN4 0HJ 1A E06000030 I SU2075

MARLBOROUGH SN8 1SZ 1A E06000054 I SU2075
MARLBOROUGH SN8 1SZ 1B E06000054 I SU2075  

Ordnance Survey provides an FME Workbench and NodeJS script to help the end-user to pre-process the 
data as described in the following sub-sections. The FME workbench can be found here, while the NodeJS 
script can be found here. Both are provided with a README file with instructions on usage. These do not 
require you to unzip the data before processing. 

The data, either full supply or COU, should now be combined in one CSV file, under one header, with an 
appended tilename column. Once the data has been pre-processed, it can be loaded into any database. The 
next sub-sections will detail the different loads of full supply and COU. 

6.2.1 Full supply  

Once the full supply CSV has been pre-processed as described in Section 6.2, the COPY load method can 
be used to load the data into your primary database table: 

COPY addressbase_core FROM ‘PATH TO PROCESSED FULL SUPPLY ' DELIMITER ',' CSV HEADER; 

https://github.com/OrdnanceSurvey/AddressBase/tree/master/Data%20Translating/FME/AddressBase_Core
https://github.com/OrdnanceSurvey/AddressBase/tree/master/Data%20Translating/Code/AddressBase_Core/NodeJS
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In this example, addressbase_core is the name of the table. You may use a different name. To use this table 
in a geospatial setting, geometry columns will need to be inserted using the following SQL: 

SELECT AddGeometryColumn (<schema_name>, 'addressbase_core', <column_name>, 27700, 
'POINT', 2); 
COMMIT; 

UPDATE addressbase_core SET geom = ST_GeomFromText('POINT(' || easting || ' ' || northing || ') 
', 27700 ) 
COMMIT; 

6.2.2 COU supply 

A similar method as stated in Section 6.2.1 can be used to insert the COU data into a database. Similarly, 
addressbase_core_cou is the name given to the database table. You may use a different name. 

COPY addressbase_core_cou FROM ‘PATH TO PROCESSED COU CSV ' DELIMITER ',' CSV 
HEADER; 

SELECT AddGeometryColumn (<schema_name>, 'addressbase_core_cou', <column_name>, 
27700, 'POINT', 2); 
COMMIT; 

UPDATE addressbase_core_cou SET geom = ST_GeomFromText('POINT(' || easting || ' ' || 
northing || ') ', 27700 ); 
COMMIT; 

6.2.3 Application of COU to the primary table 

1. If you are applying COU to your primary table, you should now have two tables in your selected 
database: 

• A primary table which contains some out-of-date data. 
• A COU table with the live data. 

2. To update your primary table, there are two basic steps to follow using SQL commands: 

• Delete all rows that contain tilenames that match the tilenames of the incoming COU. 
• Insert all rows from the COU table to the primary table. 

The following SQL commands will complete the application of COU into the primary table: 

a. Index the tilename column on to the primary table: 

CREATE INDEX ON addressbase_core (tilename); 

b. Index the tilename column on to the COU table: 

CREATE INDEX ON addressbase_core_cou (tilename); 

c. Delete from the primary table any records which have a tilename that matches a tilename from 
your COU table: 
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DELETE FROM addressbase_core WHERE tilename IN (SELECT DISTINCT(tilename) FROM 
addressbase_core_cou); 
COMMIT; 

d. Insert the live COU data into the primary table: 

INSERT INTO addressbase_core_cou SELECT * FROM abcore.abcore_cou; 
COMMIT; 
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